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 Getting started
  This chapter explains how to install the Meridian Configuration Program, and gives a general 

overview of its key features.

  Overview
  The Meridian Configuration Program is a Windows application 

that lets you design the configuration of your G Series system 

to suit both your own personal preferences and the particular 

configuration of other equipment in your system. 

It uses an intuitive graphical interface that prompts you at every 

stage for the information it needs to complete the system. When 

you have designed the system to your requirements you can save 

the configuration to the appropriate Meridian products in the 

system via a serial link connected to the back of each product.

  How it works
  The Meridian Configuration Program reflects Meridian’s system 

approach to designing audio products and presents a graphical 

representation of your whole system. It allows you to create a 

single configuration file representing the settings of each product in 

your system and the way they are interconnected. This file is stored 

in the controller of the system for future reference. As well as being 

far more convenient than configuring each product independently, 

this approach also enables the Meridian Configuration Program to 

check that the settings you are proposing are appropriate for the 

particular combination of products in the system.

The Meridian Configuration Program is structured as a wizard; 

it leads you through a series of stages from the Welcome 

page through to the Finish page, which is reached when the 

configuration has been completed. A Breadcrumb trail below the 

toolbar at the top of the Meridian Configuration Program 

window shows your current position in the sequence of pages and 

allows you to jump back to an earlier page to check a particular 

setting you made.
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  Benefits of using the Meridian 
Configuration Program
  Configuring your system with the Meridian Configuration Program 

offers several important benefits. In particular:

  • You can configure the entire system in a single operation.

• It is more convenient and more intuitive than using the front-

panel menus.

• You have access to many advanced configuration options that are 

not available from the front-panel menu.

• You can conveniently edit source, DSP preset, and other names 

using the keyboard.

• You can edit the G Series soft keys.

• If your controller is a digital surround controller you can take 

advantage of Meridian Room Correction.

• You can set up multiple systems far more conveniently than by 

manually configuring each product.

  • You can keep a record of the configuration of your entire system 

in a single document on your PC.

  If you have made manual adjustments to the configuration of 

a product from the front panel, you can fetch the product’s 

configuration into the Meridian Configuration Program as the 

starting point for the configuration of your system, in order to 

retain the settings, such as calibration settings.



Breadcrumb trail
Information bar

Products area

Tabs to add new products
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Controller
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  The  Meridian Configuration Program 
window
  The following illustration shows the key features of the Meridian 

Configuration Program window:
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   Requirements
  To use the Meridian Configuration Program you need:

  • A computer running Windows 95, 98, 2000, NT 4, ME, or XP.

• 10Mbytes of free disk space.

  • A 9-pin serial port.

  The software requires a mouse or similar pointing device – it 

cannot be operated solely from the keyboard.

  To install the Meridian Configuration Program

  • Insert the Meridian Configuration Program Installation CD-ROM.

  The Setup program should be run automatically when the CD-ROM 

is inserted. If not, locate setup.exe on the CD-ROM and run it.

The Setup program Welcome page will be displayed.

  • Follow the wizard.

  Note: Entering your personal details is optional; this information is 

only kept on your computer.

On the Preferences page:

 • Leave Install for all users selected, unless you want to restrict 

use of the program to yourself on a multi-user machine.

   Installing the Meridian Configuration Program
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 Quick tour
  This section is designed to give you a quick tour of the Meridian Configuration Program. It 

shows how to create a complete configuration for a typical simple system.

At each stage the Quick tour shows information about some of the more advanced features of 

the Meridian Configuration Program in grey tinted boxes.

  Running the Configuration 
Program
  • Click Start, point at All Programs, Meridian, then click 

Configuration Program:

  

  The  Welcome page will be displayed. This provides links to useful 

information.

  Using the Meridian Configuration 
Program
  The simplest way to use the Meridian Configuration Program is to 

click the links in the Breadcrumb trail and Information bar at the 

top of the window; for example:

  

  The  Breadcrumb trail shows a sequence of hyperlinks to pages you 

have already visited; this is indicated by the blue underline. Clicking 

one of the links takes you to the corresponding page to allow you 

to check your settings on that page, or make changes. The last 

entry on the Breadcrumb trail is usually Next, which takes you to 

the next page.

The  Information bar provides help about the current page, and 

tells you what to do next. The Information bar contains two types 

of hyperlink: definitions, prefixed by a question mark icon, which 

display a pop-up window with a definition of the item, and jumps, 

prefixed by an arrow icon, which perform an action or jump to 

another page.
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  Starting a  configuration
  To start creating a configuration from the Welcome page:

  • Click the Next link in the Breadcrumb trail:

  

  The  Products page will then be displayed. This allows you to 

define the products in your system and indicate how they are 

connected together.

  Getting help
  For more detailed information about the Meridian Configuration 

Program see the on-line help. To display the help:

  • On the Help menu, click Configuration Program Help.
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  Products:  Adding a  controller

  The controller is defined as the product that selects sources and 

controls the volume for the system; it is the digital surround 

controller, preamplifier, or combination product. In this example it is 

a G68 Digital Surround Controller.

  • Click the Insert a Controller link in the Information bar. 

  An Insert dialogue box is displayed to allow you to specify the 

type of controller.

  • Select G68ADV from the drop-down list and click the OK button 

to add the product:

  

  You will then be asked whether you want to fetch an existing 

configuration from the controller. If you are starting from scratch, as 

in this Quick tour, you do not need to do this. For more information 

see the Advanced tips on the next page.

  • Select Remember my decision to avoid further prompts of this 

type.

  • Click the No button to indicate that you do not want to fetch 

data from the digital surround controller:

  

  The Products page will then show the G68ADV Digital Surround 

Controller:

  



  Advanced tips
  Adding products by dragging them from the Resource Bar

  The most flexible way of adding products is to drag an appropriate 

icon from the Resource Bar (to the left of the Products page) 

into the Meridian Configuration Program window:

  

  

Fetching settings from a product

  If you have changed any settings on a product from the front 

panel since making a previous configuration, you can retain the 

settings by using the Meridian Configuration Program to fetch the 

configuration from the product, rather than starting from a default 

configuration as described above. This is also useful if you cannot 

locate the file on the computer.

  • Connect a serial cable between the product and your PC.

  Follow the instructions in Post-calibration fetch, page 22.

  Performing other actions

  • Click with the right mouse button on most objects in the 

Meridian Configuration Program window to display a 

context menu of actions appropriate to that object:

  For example, to delete a product:

  • Click the product with the right mouse button and click Delete 

on the context menu.

  Note: If you delete the controller you will need to restart the 

configuration from scratch.

  Displaying or changing product properties

  Many products provide a range of properties that you can change 

for specific situations. To display the product properties:

  • Click the product with the right mouse button and click 

Properties on the context menu or double-click the product 

icon.

8
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  The Properties dialogue box shows a list of the properties 

associated with the product, and allows you to view or change 

their values:

  

  Changing the value of a property

  • Click the value of the property.

  • Choose an option from the drop-down list:

  If it is a numeric property you will get a spin button rather than a 

drop-down list:

  If you have changed the value of a property an * is shown after its 

name.

  Restoring a property to its default value

  • Click the property with the right mouse button and click Revert 

to Default on the context menu:

  The menu option shows the default value.

For detailed information about what each of the properties mean 

refer to the Configuration chapter in the Installation Guide for the 

product, or the FAQ in the Meridian Configuration Program on-line 

help.
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  The next step is to add the sources in your system. For this Quick 

tour we will assume a satellite receiver is required.

  • Click the Insert a source link in the Information bar.

  

  An Insert Source dialogue box is displayed to allow you to select 

the type of source.

  • Choose Satellite from the drop-down list, and click the OK 

button to add the source:

  

  The  Connection Wizard is then displayed to assist you in 

connecting the source to your other equipment:

  

  • Leave Yes selected to make the recommended connections 

between the source and the controller.

  The Meridian Configuration Program will use a set of connections 

which match the back panel screening of the controller to make 

wiring up straightforward

  • Click the Finish button to make the recommended connections.

  The connections will be displayed on the Products page:

  

  This shows the audio connection between the satellite receiver 

optical output and the optical input O1 on the digital surround 

controller, and the S-video and component video connections 

between the satellite receiver and the digital surround controller.

You can now proceed to add the other sources in your system in a 

similar way. In this example we are only inserting a single source.

See the Advanced tips opposite for information about modifying 

these connections; eg to use analogue rather than optical for 

audio. 

  Products:  Inserting a  source



  Advanced tips
  Showing a list of the recommended connections

  If you choose the Yes (recommended) option in the Connection 

Wizard dialogue box, you can preview the recommended 

connections.

  • Click the Details… button in the Connection Wizard dialogue 

box:

  

  Renaming a source

  You can give each source a name of up to five characters to 

identify it on the front-panel display:

  • Click the source with the right mouse button, then click 

Rename… on the context menu:

  The following dialogue box allows you to enter a new name:

  

  Changing the MSR+ key for a source

  You can choose which MSR+ key selects each source:

  • Click the source with the right mouse button, then click 

Properties on the context menu.

• Click the Source tab in the Properties dialogue box.

  • Choose the MSR+ key from the MSR+ key drop-down list:
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  Showing and hiding connections

  You can choose whether or not source connections are displayed 

by clicking the View or hide source connections button in the 

toolbar:

  

  To display information about the style of each connection line:

  • On the View menu, click Legend.

  Connecting using drag and drop

  You can also connect between any two compatible connectors 

using drag and drop:

  • Drag between the output on the source and the input on the 

controller that you want to connect:

  When you release the mouse button the cable will be connected:

  If the connectors are incompatible a stop cursor will be displayed:

  Removing a connection

  • Drag from one of the connectors and release the mouse button:

  The cable connecting the two products will be removed.

  Making a multichannel connection

 If you are connecting a product with multichannel outputs, such 

as a G98DH DVD Player, to a digital surround controller with 

multichannel inputs, the Meridian Configuration Program can 

create a multichannel configuration when you drag between two 

appropriate connectors:
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  A prompt allows you to choose whether to make a single or 

multichannel connection.

  If you choose Yes the multichannel connection will automatically 

be made:

  Adding or removing inputs or outputs

  You can add new inputs or outputs, or remove inputs or outputs, 

to reflect the connectors provided by your source. For example, if 

your satellite receiver includes a digital coax output you can add a 

connector for this:

  • Click one of the source’s existing connectors with the right mouse 

button, point to Connection, then click New… on the context 

menu:

  The Add connector dialogue box allows you to define the new 

connector.

  • Specify the type of connector using the Class and Type drop-

down list, enter a name, and choose Output or Input as 

appropriate:

  

  • Click the OK button to add the connector.
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  The next step is to add the speakers in your system.

  • Click the Insert a Speaker link in the Information bar.

  The Insert Speaker dialogue box allows you to select which type 

of speaker you want to add, and the positions in which to add it.

  • Select the type of speaker from the Type drop-down list.

  • Select the appropriate Location option.

  Size will automatically be set to Large for speakers known to have 

good bass handling, or Small otherwise:

  

  • Click the OK button to add the speakers. 

  The speakers will be added to the appropriate points in the layout, 

and the connections will automatically be made between the 

speakers and the controller:

  

  • Click the Insert a Speaker link again and click DSP5500HC on 

the Type drop-down list to add a centre speaker:

  

  The program will offer to add a 511 patch box to the layout to 

connect the Comms cables for the speakers.

  • Click the Yes button to confirm.

• Click the Insert a Speaker link again and click Analogue 

Passive on the Type drop-down list to add, for example, small 

analogue rear speakers.

  Products:  Adding  speakers
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  • In the Size section select Small to indicate that these speakers 

should not handle bass: 

  

  • Click the OK button to add the speakers.

  The Meridian Configuration Program will automatically prompt you 

to add an amplifier to the layout to drive the passive speakers.

  • Click the Yes button.

  • Click G57 on the Amplifier type drop-down list, and click the 

OK button to add the amplifier:

  

  The G57 will automatically be connected up to the appropriate 

analogue output on the digital surround controller:

  

  Finally insert a subwoofer into the layout:

  • Click the Insert a speaker link in the Information bar and click 

Subwoofer on the Type drop-down list:

  

  You can proceed to add any other speakers in your layout in a 

similar way.

  • Click the Next link in the Breadcrumb trail to proceed to the next 

page.



  Advanced tips
  Adding a speaker by dragging it from the Resource Bar

  • Drag an icon from the Speakers panel of the Resource Bar (to 

the left of the Products page):

  

  • Drop it onto the appropriate speaker position.

  Adding a speaker at a specific position

  • Click the position with the right mouse button, point to Insert, 

then click Speaker…, on the context menu:

  Alternatively, double-click the speaker position.

  Reviewing and printing the source and speaker 

connections

  You can display a list of the source and speaker connections, as a 

checklist, and print out a copy for help in wiring up the system.

  • On the View menu, click Review Pages.

  Additional Speaker connections and Controller connections 

pages will be available in the Breadcrumb trail.

  • Click Speaker connections or Controller connections to 

display the appropriate list of connections:

  

  Displaying or changing the speaker properties

  To display the speaker properties, double-click the speaker icon 

or click the speaker icon with the right mouse button and click 

Properties on the context menu:

  

  You can edit the properties in the same way as for source 

properties.

  Specifying whether the speaker should handle bass

  If you do not want a speaker to handle bass click its icon with the 

right mouse button and click Treat as Small on the context menu:
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  Soft keys

  Advanced tips
  Changing the soft key layout

  • Drag a soft key from the left-hand list onto the set of soft keys 

you want to edit:

  

  The first 12 buttons correspond to the 12 MSR+ keys. Only the 

ones corresponding to the sources you have defined in your system 

will be available – the others will be greyed out. Their names will 

reflect the names you have given the sources on the Products 

page. 

  Soft keys that work in pairs, such as balance, bass, treble, and 

bright, automatically occupy two adjacent soft key positions. 

  Renaming a source

  • Click the source button with the right mouse button, and click 

Rename Source… on the context menu:

  All occurrences of the source in the soft key sets will be changed.

  Clearing a soft key

  • Click the soft key with the right mouse button and click Remove 

on the context menu:

  Restoring the recommended layout

  • Click the Reset button for a recommended assignment of soft 

keys.
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  The  Soft keys page allows you to customise the soft keys for each 

of the G Series products in the system starting with the controller. 

In this example the only applicable product is the G68ADV.

An initial recommended layout is provided for each product; for 

example, for a G68 this provides soft keys for each of the sources 

in the system, plus a DSP key in the rightmost position.

  • Click the Next link in the Breadcrumb trail to proceed to the 

next page.
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  The  Bass management page specifies how bass is handled in 

the system for each of the three speaker layouts. The settings are 

automatically set to recommended values and can be ignored for a 

simple configuration.

  • Click the Next link in the Breadcrumb trail to proceed to the next 

page.

  Bass management



  Advanced tips
  Meridian digital surround controllers allow you to define three 

different speaker layouts for use with different types of material: 

Music, Logic, and 5.1 Movie. The Bass management page allows 

you to specify how the bass is handled in each speaker layout:

  

  You can select the subwoofer configuration, and whether the 

centre speaker is used in the layout, in the Speaker usage 

section. Information about your choice will be displayed below the 

Speaker usage section.

If you include only one subwoofer in the layout, and you have 

specified your main speakers as Small, the subwoofer will be used 

for the bass and LFE. If the main speakers are Large the Front 

subwoofer option allows you to choose whether the subwoofer 

handles just the LFE, all the bass (Bass-neutral), or the bass 

together with the main speakers (Bass-heavy).

If you include two or more subwoofers in the layout, irrespective of 

the size of the main speakers the subwoofers will handle the bass 

and LFE for the system.

The Crossover option allows you to set the crossover frequency 

for the subwoofers. This is disabled if the subwoofers are only 

handling the LFE. The Meridian digital surround controllers provide 

very high-quality crossovers for the subwoofers, and for best results 

you should use these instead of the subwoofer’s crossover. To do 

this set the subwoofer Width property to Narrow, and remove 

any crossover in the subwoofer or set it to the highest setting (eg 

200Hz). If you cannot do this set the subwoofer Width property to 

Wide to switch off the digital surround controller’s crossover and 

use Sine/Sub mode to match the subwoofer’s crossover frequency.

The LFE low pass filter option sets the low-pass filter for the LFE 

channel, for the Music and 5.1 Movie speaker layouts.

Click the Reset button to reset the crossover and low-pass filter to 

recommended values in all layouts.

In addition, a THX settings panel allows you to specify that your 

subwoofers are THX Ultra2 approved, and select Boundary 

gain compensation to reduce bass levels if listeners are close 

to a wall. Click the THX Defaults button to set the crossover and 

low-pass filter to 80Hz in all layouts, as recommended by THX.

Q u i c k  t o u r

1 9



  Advanced tips
  • Click the A or V buttons to the left of the scale indicator to 

change the scale of the whole diagram.

• Click the speaker to select it, and then use the arrow keys to 

move the speaker in the corresponding direction.

• Use c^ and cV to move a speaker away from or 

towards the listening position. Hold down S to move all the 

speakers at once.

• Use the c< and c> to move a speaker in a circle around 

the listening position.

  • Click the Scale to Fit button to increase the scale so the 

loudspeakers neatly fit in the screen.
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  Speaker distances

  The  Speaker distances page gathers information about the 

relative positions of the speakers in your system, and the distance 

of each speaker from the listening position. First choose the units 

you would like to work in.

  • On the View menu, click Metric or Imperial.

• Measure the distance to each speaker in the specified units.

  • Drag the speakers until they are in the correct positions, with the 

correct distance shown on each speaker icon.

  This information is used to generate the aspect ratio and rear 

speaker separation.   

  • Click the Next link in the Breadcrumb trail to proceed to the 

next page.



  Advanced tips
  Specifying the serial port

  • Click the  Options… button on the Pre-calibration store page 

to display the Comms Port panel on the Options dialogue box:

  

  • Select the port you want to use and click the OK button.
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    Pre-calibration store

  The  Pre-calibration Store page stores the settings you 

have created to the G68 Digital Surround Controller and then 

automatically starts the calibration sequence so you can tune your 

speakers by ear using a series of listening tests.

  To connect the  serial cable

  • Connect one end to the RS232 connector on the back panel of 

the controller in your system.

  • Connect the other end to one of the serial ports on your 

computer.

  The default is COM1. If you have to use a different port see 

Advanced tips below.

  • Click the Start button to begin. 

  When the store has completed successfully the calibration 

procedure will start automatically and you will hear a noise signal 

from the first speaker in your layout. Refer to the G Series Digital 

Surround Controller Installation Guide for information about 

calibrating your system.

  • Click the Next link in the Breadcrumb trail to proceed to the next 

page.
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   Post-calibration fetch

  The  Post-calibration fetch page fetches the calibrated settings 

from the digital surround controller so you can complete the 

configuration.

  • Click the Start button to start the fetch.

  When the fetch is complete:

  • Click the Next link in the Breadcrumb trail to proceed to the 

next page.

  



  Advanced tips
  The Speaker properties page allows you to edit the distance, 

gain, and phase for each speaker and the size for large analogue 

speakers or subwoofers:

  

  • Click the value in the distance, gain, or phase, and either type in 

the new number or select the appropriate value from the drop-

down list.
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  Speaker properties

  The  Speaker properties page allows you to check or edit the 

calibration of the speakers in the system.

This allows you to review the changes made during the calibration, 

and you should not normally need to alter the settings.

  • Click the Next link in the Breadcrumb trail to proceed to the 

next page.
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  Room Correction store

  The  Room Correction Store page runs the Meridian Room 

Correction procedure. This is optional and you can skip this stage 

by clicking the Next link in the Breadcrumb trail

For information about running the Room Correction procedure see 

the chapter Room Correction, page 29.

  • Click the Next link in the Breadcrumb trail to proceed to the 

next page.



  Advanced tips
  The Preset properties page shows the name and value of each 

of the preset properties:

  

  Displaying the properties for a preset

  • Select the preset in the left-hand list.

  Changing the value of a preset

  • Click the value of the preset.

  • Choose an option from the drop-down list:

  If it is a numeric preset you will get a spin button rather than a 

drop-down list:

  If you have edited a preset an * is shown after its name.

  Restoring a preset to its default value

  • Click the preset with the right mouse button and click Revert to 

Default on the context menu:

  The menu option shows the default value.

For full information about the parameters for each DSP preset see 

the G Series Digital Surround Controller Installation Guide.
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  Preset properties

  The  Preset properties page shows the list of the presets 

available to the digital surround controller, and allows you to edit 

the values of each preset.

For a simple configuration you can skip this page.

  • Click the Next link in the Breadcrumb trail to proceed to the 

next page.



  Advanced tips
  Changing the preset mapping

  • Click the preset in the appropriate music format column and 

select the preset you want to be used for the default on the 

drop-down list:
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  Preset mapping

  The  Preset mapping page allows you to specify the default DSP 

preset selected for each source, and each audio format. You can 

skip this page for a simple configuration.

  • Click the Next link in the Breadcrumb trail to proceed to the 

next page.
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    Store  settings

  This page stores the settings to the G68.

  • Connect the serial cable.

  For more information see Pre-calibration Store, page 21.

  • Click the Start button to store the settings.

  When the store has completed:

  • Click the Next link in the Breadcrumb trail.
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  Finish

  The Finish page confirms that you have successfully completed the 

configuration of your system.

  Save a copy of your  configuration 
  It is recommended that you save a copy of the final configuration 

document on your PC, with an appropriate name, so that you can 

refer to it again at a later date, if necessary.

  • On the File menu, click Save.

  A copy of the configuration document is also saved in the 

controller for your system, so if necessary you can retrieve it at a 

later date. 
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  Room Correction

  Introduction
  The Meridian Room Correction program works in conjunction 

with the Meridian Configuration Program to create a set of one 

or more room correction profiles matched to your room. These are 

then downloaded to the digital surround controller and can be 

associated with particular presets, or selected from the front panel. 

Selecting a profile applies a set of digital filters individually to each 

speaker to achieve the required room correction. 

If you use a single loudspeaker layout you may choose to have one 

room correction profile, and use this with all presets. If you have 

separate speaker layouts for use with Music, Logic, and 5.1 Movie 

sources you will need to calculate a separate room correction profile 

for each speaker layout. These will then be selected automatically 

by the digital surround controller depending on the audio format. In 

addition, you can create separate room correction profiles to take 

account of changes to the room, such as the position of large items 

of furniture, or with curtains open or closed.

  How   room correction profiles are 
calculated
  Calculating a room correction profile is a time-consuming and 

mathematically complicated process. The Meridian Room Correction 

program performs the necessary sequence of measurements and 

calculations completely automatically, using a PC connected to 

the digital surround controller, with the minimum of interaction. It 

works as follows:

First you need to set up a microphone close to the listening 

position, and connect this to the A8 (L) input of the G68 Digital 

Surround Controller. Usually a standard sound pressure level meter 

will be used as a microphone; this can be the same one used for 

setting the speaker levels using the Calibration procedure. After an 

  The G68 Digital Surround Controller incorporates room correction, which takes advantage of 

advanced digital signal processing techniques to compensate for room artefacts, including 

resonances and reflections, to give a significant improvement in the sound.

This chapter explains how to run the Meridian  Room Correction program and use it to create 

profiles for use with the digital surround controller.
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initial short test sequence, designed to check that the microphone 

is set up correctly, a series of test signals are presented to each 

loudspeaker and measured at the microphone to determine how 

the room response affects the sound from each speaker. This phase 

of the procedure takes about one minute per speaker, and can be 

left to run unattended. 

Finally after a complete set of measurements has been made 

for each channel and speaker layout, the program calculates a 

set of filters for each channel, and stores these to the digital 

surround controller. A copy of the measurements, together with the 

calculated filters in each profile, is also stored on the PC so they 

can be accessed at a later date if required. All the room correction 

settings and measurements will be saved in a folder named after 

the MSL file. For example if your MSL file is called G68_theatre.msl 

then all of the room correction settings and measurements will be 

in a folder called G68_theatre.mrd.

  Examples
  Most domestic rooms tend to be rectangular, or at the very least 

have one pair of parallel facing walls, and unfortunately these are 

the ideal conditions for low frequency resonances within the room. 

The wavelength of low frequency sounds is relatively large, so even 

bookcases and curtains act as an almost perfect mirror for low 

frequencies. 

Frequencies close to the resonant frequency, determined by the 

distance between the two reflective surfaces, will sound louder and 

take longer to decay than other frequencies. In practice this means 

that when listening to music some notes will sound louder, giving a 

roughness or unevenness to the sound.

Other problems that can be corrected by room correction are 

imbalances between the speakers due to positioning constraints. 

For example, in an L-shaped room one loudspeaker may need to be 

close to the wall whereas its partner is in an open area, giving rise 

to an imbalanced sound field. 

Unless your listening room has been specially designed for acoustic 

performance, you will almost certainly hear distinct benefits after 

incorporating room correction into your digital surround controller, 

and if the room has major resonances or imbalances the difference 

should be quite dramatic.

You can find more information about the theory behind Meridian 

Room Correction on the Meridian Web Site at: 

http://www.meridian-audio.com/p_rc.htm
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  This section explains how to create a basic room correction using 

default settings.

The Room Correction program is run from within the Meridian 

Configuration Program, and adds the room correction profiles to 

the current configuration file.

The room should be as you would normally use for listening. Close/

open doors, close/open curtains, and position your screen and 

furniture as they would normally be for listening.

  To run the Room Correction program

  • Click the Store button on the Room Correction store page.

  After successfully storing the configuration to the surround 

controller the MRC set up wizard will be displayed:

  

  • Click the Next button to continue.

  The next page allows you to set up the input for microphone or 

Sound Pressure Level meter:

  

  • Leave the input sensitivity at the default value.

• Click the Next button to continue.

  • Connect the SPL meter or microphone to the analogue input 

A8 (L), switch on the SPL meter and position it at the listening 

position.

  When using an SPL meter the C weighting must be used, and the 

90dB range is recommended, unless the loudspeakers measured 

less than 75dB SPL during the calibration in which case the 80dB 

range is recommended.
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  • Click the Test mic button to run a test to check that the 

microphone is connected correctly:

  

  The following dialogue box will count down to the test:

  

  A signal will then be played through the main left loudspeaker.

  • Check that the SPL meter reading does not indicate that the 

input signal is too large for the selected range.

  On some meters this is indicated by the reading going above 0dB 

into the red range of the meter, and on others by the word high 

appearing on the display.

  The MRC set up wizard will then indicate whether the test was 

successful:

  

  If the test did not complete successfully check the SPL meter or 

microphone connections and the input card and connector settings 

and try again. For more information about problems with the 

microphone test see Troubleshooting, page 48.

  • Click the Next button to continue. 

  The next screen lets you choose whether to do an automatic room 

optimisation, or create profiles manually.
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  The Automatic option is recommended unless you are 

experienced in using the Meridian Room Correction program:

  

  • Select the appropriate option.

  • Click the Finish button to continue.

  The following prompt then allows you to start the automatic room 

correction process:

  

  • Click the Start… button to begin. 

  A countdown dialogue box will give you time to leave the room.

  The Room Correction program will then present a test tone to each 

loudspeaker in turn for each of the distinct layouts defined in the 

digital surround controller Configuration file: 

  

  Depending on the number of channels and layouts in your 

configuration this may involve up to 24 tests and take up to 20 

minutes to complete.
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  When the measurements have been completed the Build filters 

dialogue box will be displayed showing the filters being built for 

each channel and each speaker layout in turn:

  

  Finally the calculated filters will automatically be stored to the 

digital surround controller.

  The following dialogue box confirms that the Auto set up has 

completed successfully:

  

  • Click the Close button to close the dialogue box.

  You will then be given the option of saving the settings:

  

  • Click the Yes button to save the settings and return to the 

Meridian Configuration Program. 

  All the room correction settings and measurements will be saved 

in a folder named after the MSL file. For example if your MSL file is 

called G68_theatre.msl then all of the room correction settings and 

measurements will be in a folder called G68_theatre.mrd.

You will then return to the Room Correction store page.

  To apply the room correction profiles

  The following dialogue box allows you to apply the room correction 

profiles:

  

  • Click the Yes button to assign an appropriate profile to each 

preset. 
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  Each preset will be assigned the profile designed for the layout 

used with the preset. The wizard creates profiles called Mus, Log, 

and Mov for the Music, Logic, and 5.1 Movie Speaker layouts 

respectively. If two or more layouts share the same settings, the 

profile name will include all the layouts it applies to; eg MusLog or 

MusLogMov.

  What next?
  You have now completed the Auto set up, which creates a 

recommended set of room correction profiles. In most situations 

this is all you need to do in order to take advantage of room 

correction with your digital surround controller.

The next sections describe some of the more advanced options 

available in the Meridian Room Correction program, including 

the options for re-measuring channels, creating multiple profiles, 

selecting different filter parameters, and manually editing the filters.
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  The  Measurements panel shows a measurement for each of 

the speaker layouts set up in the digital surround controller 

configuration. You can also create additional measurements, 

such as to cater for different furniture layouts, and for each 

measurement you can view the effect of applying different profiles:

  

  For each speaker layout the Measurements list shows a list of 

the channels to be measured, or All for all channels, with channels 

already measured shown in bold.

The Measurements panel gives you the option of viewing 

or comparing the measurements. You can also repeat the 

measurements for individual speakers, for example if an external 

noise interfered with the test procedure. 

  To display the measurements

  • Run the Meridian Room Correction program.

• When the Set up wizard is displayed click the Cancel button.

  • Click the Measurements tab.

  To view the  measurements

  • Click with the right mouse button on the measurement you 

want to view, point to View Measurement, then click the 

appropriate channel on the context menu:

  

  The Plot measurement window allows you to see the 

measurement for the specified channel:

  

  Viewing and repeating measurements
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  You can select one of the following three graph types from the 

Graph type drop-down list. All three views of the measurement 

are calculated from the same measured test signal:

   Impulse response

  

  Shows the response over time of the loudspeaker to a click. The 

curve shows a maximum just after time zero, and then decays 

rapidly depending on the amount of reverberation in the room. Any 

additional peaks in the response indicate resonances set up by the 

initial impulse.

   Low frequency response

  

  Shows the loudspeaker-room response to a low frequency sine 

wave, swept between 0 and 250Hz. The ideal low frequency 

response would be smooth. A peak in the response indicates a 

resonance at the corresponding frequency. A dip in the response 

indicates absorption or cancellation at the corresponding frequency.
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   Waterfall plot

  Shows the response of the room to a series of short sine wave 

pulses of frequencies between 0 and 250Hz. It shows how the 

response decays over time at each of those frequencies.

The ideal waterfall plot would have a smooth profile and decay 

evenly to a low level within 0.5 to 0.8 seconds. Peaks or dips 

in the waterfall plot indicate resonances or absorption at the 

corresponding frequency. Ridges extending forwards in time 

indicate reverberation at the corresponding frequency. 

The room correction profile aims to identify the strongest 

resonances and to reduce the decay time of each strong resonance 

to the average decay time for the room.

   To compare two measurements

  The  Plot measurement window allows you to display a particular 

graph type for two different profiles, or show the effect of one 

profile compared to the original uncorrected room.

  • Choose the first profile to be compared from the Profile drop-

down list, or choose Bypassed to display the uncorrected 

measurements for the channel.

  • Choose the second profile to be compared from the Second 

graph drop-down list.

  The two graphs will be displayed one above the other on the 

screen:
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  To change the axes

  • Click the Axes… button in the Plot measurement window.

  The Set axes dialogue box allows you to set the range of the x, y, 

and z (waterfall plot only) axes:

  

  • Click the Update button to update the axes.

   To repeat measurements

  You can repeat measurements for one or more channels; 

for example, if an external sound interfered with an existing 

measurement.

  • Click with the right mouse button on the measurement you want 

to repeat, then click Speakers… on the context menu:

  

  The following dialogue box allows you to select which channels 

you want to repeat:

  

  • Select the channels you want to repeat, or click the Toggle 

button to swap the set of selected channels.

  • Click the OK button to confirm your selection.

  The following dialogue box warns you that the existing 

measurements will be overwritten:

  

  • Click the Yes button to continue, or the No button to retain the 

existing measurements.

  • Click the Measure… button to measure the specified channels.
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  The following dialogue box then indicates how long the selected 

measurements will take, and gives you an opportunity to leave the 

room before the test sequence begins:

  

   To create multiple measurements

  You can create additional measurement sets to take account of 

different configurations of the room, such as with curtains open or 

closed.

  • On the Measurements panel, click the Add button.

  A new measurement set will be added to the list, with the default 

name measurement.

  • Click the Rename button to rename the measurement set.

  • Select the new measurement set and click the Measure… 

button to measure all the channels for each of the speaker 

layouts. 

  To delete a measurement set

  • Select it in the Measurements list and click the Delete button.
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  After creating a measurement set you need to create a profile for 

each of the speaker layouts in each of the measurement sets.

The Profiles panel shows a list of all the active profiles and allows 

you to create new profiles and build the filters for each profile.

   To create a profile for each layout

  • Click the Add button.

  A new profile will be added with the default name profile.

  • Select the speaker layout from the Layout type drop-down list:

  

  • Repeat to create profiles for each of the other layouts.

    To build the filters for a profile

  • Select the profile in the Active profiles list and click the Build 

filters… button.

  The Build filters dialogue box is displayed to allow you to specify 

the target decay time:

  

  By default a target decay time is automatically calculated for 

the layout, but you can specify a value manually if you prefer, as 

follows:

  • Select Manual and enter the decay time, in milliseconds, in the 

field. 

     Creating multiple profiles
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  Choosing a shorter decay time will lead to a profile with more 

filters, and filters which are deeper, which will take more bass 

out of the signal. Typically a decay time of 350 milliseconds is 

appropriate for domestic listening, and 200 milliseconds gives a 

drier reverberation suitable for a studio.

  • Click the Build filters… button to start building the filters.

  If you have more than one measurement set the following dialogue 

box is displayed to allow you to select which measurement set you 

want to use for the filters:

  

  Note: The process of building filters is computationally intensive, 

and it is recommended that you do not try to run other programs 

at the same time.

  As the filters are calculated the response will be displayed in 

the lower half of the dialogue box. When the filters have been 

completed, the status of each filter will be shown as Complete, 

and you can click on it to display the response:

  

  • Click the Close button to close the Build filters dialogue box.
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  After building filters for a profile the Active profiles list shows 

the number of filters used for the profile, and the number of 

remaining filters available: 

  

  Each profile can use up to 60 filters; if a profile requires more 

filters than this, filters will be allocated in order of priority.

Each channel is limited to a maximum of 20 filters; a two-channel 

system therefore has a limit of 40 filters.

  To store profiles temporarily to the digital surround 

controller

  You can store profiles temporarily to the digital surround controller 

so you can listen to them while using the Meridian Room 

Correction program.

  • Click the Store… button.

  The following dialogue box confirms that the profiles have been 

stored:

  

  • Click the OK button to continue.
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  After building the filters for a profile you can edit the filters 

numerically or graphically to adjust their parameters, or change the 

response of each filter. 

Note: This should only be attempted by users with an 

understanding of filter design. It is strongly recommended that you 

copy the profile first and then edit the copied profile. There is no 

undo function within Edit filters.

   To display the filters for a profile

  • Select the profile in the Active profiles list.

  • Click the Edit filters… button.

  The following dialogue box shows a list of the channels, and a list 

of the filters for each channel, together with the parameters for 

each filter:

  

  • Select the channel in the Channel list to display the filters for 

that channel.

  The columns give the filter number, centre frequency (Hz), 

gain (dB), and filter bandwidth (Hz), and you can adjust these 

parameters for each filter.

In addition, the list of filters shows the Room mode bandwidth 

(Hz), Equalized bandwidth (Hz), RT60 (s), and Target RT60 (s). 

  To edit a filter numerically

  • Select the filter in the Filters list.

  • Adjust the frequency, gain, and width in the fields below the 

Filters list.

  To edit a filter graphically

  • Click the Graphical tab to display the Graphical panel in the 

Edit filters dialogue box.

  • Select the channel in the Channel list to display the filters for 

that channel in the Filter response graph:

  

    Editing  filters
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  • Select the filter you want to edit by clicking on the square above 

the filter trough:

  

  Alternatively if the filters are close together you can select a 

specific filter using the Filter field below the Filter response curve.

The filter will be displayed with a red vertical bar at the filter centre 

frequency, and a rectangle indicating the bandwidth of the filter.

You can edit each parameter of the filter interactively as described 

in the following sections.

  Centre frequency

  • Drag the vertical bar to the left or right on the filter response 

curve:

  

  Gain

  • Drag the handle at the base of the filter:

  

  Bandwidth

  • Drag one of the handles on either side of the filter:

  

  To add a filter

  •  Click the Add button on the Numerical or Graphical panel.

  • Edit the parameters of the filter as described above.

  To delete a filter

  • Select the filter you want to delete in the Filters list, or on the 

Graphical panel. 

  • Click the Del button.
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  This section describes how to change the room correction or 

configuration settings of the digital surround controller at a later 

date, subsequent to uploading the original version.

Note: You can only edit or add to existing profiles if you have the 

MSL file and mrd folder originally used to design the profile. If you 

do not have the original MSL file and mrd folder you will need to 

make new measurements, create new profiles, and then store these 

to the digital surround controller.

  To edit an existing profile, or add a new profile

  • Run the Meridian Configuration Program and open the MSL file 

used to create the original profiles.

  If you have changed settings on the digital surround controller 

since the original profiles were made, and you want to retain these 

changes:

  • On the File menu, click Save as to save the MSL file under a 

new name.

  This will also create a renamed copy of the mrd folder containing 

the original measurements and profiles.

To fetch the settings from the digital surround controller:

  • On the Products page, click the controller with the right mouse 

button, then click Fetch… on the context menu.

• Run the Meridian Room Correction program.

• When the Set up wizard is displayed click the Cancel button.

  • Select the Profiles tab, and proceed as described in Editing 

filters, page 44, or Creating multiple profiles, page 41.

  To change other settings if you have the original MSL file 

and mrd folder

  • Run the Meridian Configuration Program and open the original 

MSL file.

  If you want to keep the original settings:

  • On the File menu, click Save as to save a copy of the MSL file 

and mrd folder under a new name.

  • Change the settings as required and store the new settings to 

the digital surround controller.

  For more information about changing configuration settings using 

the Meridian Configuration Program refer to the G68 Digital 

Surround Controller Installation Guide.

  To change other settings if you have lost the original MSL 

file and mrd folder

  If the original MSL file and mrd folder are not available you will be 

able to change all non-room correction settings, and which room 

correction profile you want to use with a given preset.

  • Start a new document.

  • On the File menu, click Fetch to fetch the settings from the 

digital surround controller.

   Changing settings at a later date 
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  The newly created file will contain the profile labels and these 

can be used to choose the profile you want to use with a given 

preset. It will not contain measurements or profile data for the 

Meridian Room Correction program. If you use the Meridian Room 

Correction program to create new measurements and profiles and 

store these to the digital surround controller, the old profiles will be 

overwritten.

  • Change the settings as required and store the new settings to 

the digital surround controller.

  For more information about changing configuration settings using 

the Meridian Configuration Program refer to the G68 Digital 

Surround Controller Installation Guide.

  To change other settings directly on the digital surround 

controller

  For information about changing other configuration settings on 

the digital surround controller refer to the G68 Digital Surround 

Controller Installation Guide.

After making changes on the digital surround controller you can 

add these changes to an existing MSL file as follows:

  • Run the Meridian Configuration Program and open the original 

MSL file.

  • On the Products page, click the controller with the right mouse 

button, then click Fetch… on the context menu to fetch the 

new settings from the digital surround controller.

  If you want to keep the original settings:

  • On the File menu, click Save as to save a copy of the MSL file 

and mrd folder under a new name.

  This will also create a renamed copy of the mrd folder containing 

the original measurements and profiles.



R o o m  

c o r r e c t i o n

4 8

  This section gives suggested solutions to typical problems that 

may occur when using the Meridian Room Correction program. 

If problems still persist after working through the following steps 

please send an email to support@meridian.co.uk with a zip file 

containing your MSL file and all the files in the associated mrd 

folder and its subfolders. For example if your MSL file is called 

G68_theatre.MSL then please send a zip archive containing this 

file together with all files in the G68_theatre.mrd folder and its 

subfolders. Please also supply details of the loudspeakers and 

amplifiers you are using.

  Failed microphone/SPL meter test

  During the microphone/SPL meter test details are displayed in the 

following dialogue box:

  

  The pass/fail status of the microphone measurement is based on 

the Power and SNR (signal to noise ratio) values. In most rooms 

and with most SPL meters Power will usually be in the range –25 

to –35, and SNR will usually be in the range 44 to 60. The larger 

the SNR the better the measurement. 

  The following sections describe some of the most likely problems 

which will cause the Power and SNR values to go outside these 

ranges.

  Power less than –44

  The following error will be displayed:

  

  This indicates that there is very little or no signal on the connector 

you have chosen as your microphone input. Check the following:

  • That there was sound from the front left speaker during the test.

  If in doubt, repeat the microphone/SPL meter test. If there is still no 

sound check the connections from the digital surround controller to 

the left loudspeaker. Switch the digital surround controller off and 

then on again, select Calibrate as described in the G68 Digital 

Surround Controller Installation Guide, and check that the left 

speaker plays the calibrate signal.

    Troubleshooting
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  • The lead from the SPL meter is intact.

  • The SPL meter is switched on and set to the 90dB band, or the 

band which includes 90dB, and with C weighting.

  If the loudspeakers measured less than 75dB SPL during the 

calibration phase it may be better to use the 80dB range.

  • The lead from the SPL meter is connected to the correct input, 

A8 (L) on the G68.

  • The Sensitivity setting is adequate for the SPL meter or 

microphone.

  The sensitivity value for analogue inputs is given in rms volts 

(Vrms). For example a sensitivity of 1Vrms allows a signal of 

2.8Vpp. A sensitivity of 1V is recommended for use with most SPL 

meters though 0.7V may be preferable for those with lower level 

output.

  Power OK, SNR less than 18

  The following error will be displayed:

  

  The most likely cause of this problem is that an analogue source is 

connected to the input chosen for the microphone. 

  • Check that the lead from the SPL meter is connected to the input 

you have chosen for the microphone test. 

  Another possibility is that the lead from the SPL meter is in bad 

condition and only making a poor connection.

  Power OK, SNR between 18 and 34

  The following error will be displayed:

  

  The reasons for this are described in detail in the following section 

where example measurements are also shown.
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  Repeated measurements due to poor SNR

  Measurements are retried until the SNR is larger than 39 (35 for 

subwoofers) or the maximum number of retries have been made. 

The maximum number of times each measurement will be retried 

due to poor SNR can be set in the Preferences dialogue box, 

accessed from the Options menu:

  

  The default number of retries is 3. If the measurements are 

consistently giving poor SNR figures you can reduce the number of 

retries. However, it is better to follow the steps described below to 

improve the measurement conditions. The better the measurement 

the more accurate the results when calculating the filters for a 

profile.

  SPL meter is set on a low band

  The following graph shows an impulse response obtained when a 

Radio Shack SPL meter was set on the 60dB band. The SNR value 

was only 22:

  

  SPL meter is set on a high band

  The following graph shows an impulse response obtained when a 

Radio Shack SPL meter was set on the 120dB band. The tail of the 

response is generally noisy. The SNR value was 39 but the Power 

was only –48:

  



R o o m  

c o r r e c t i o n

5 1

  Loudspeaker is running in a non-linear range

  The effects of a loudspeaker running in a non-linear range is most 

easily observed in the impulse response. The tail of the response 

has small spikes, as shown in the plot below, where it should be 

zero. The larger these spikes are relative to the largest value at the 

beginning of the impulse response the smaller the SNR value:

  

  Check the following:

  • That the bass protection size has been correctly set – see the 

G68 Digital Surround Controller Installation Guide for details.

• That the bass drive unit in your loudspeaker is not rubbing.

  • That your amplifier is not clipping.

  If problems are still encountered, use the phase/gain tab under 

speaker layout to reduce the gain of the channel. Use the reduced 

gain setting for the room correction measurements, then return 

to the correct level for a calibrated system after running room 

correction measurements.

  Hum in the system

  The effect of hum on the measurement is most easily observed in 

the waterfall plot. The continuing signal at 50Hz and 150Hz in the 

waterfall plot shown below indicates a mains hum loop:

  

  You are likely to have heard this level of hum when playing 

analogue sources connected to the same analogue input card as 

the microphone/SPL meter. 

In order to get a better measurement disconnect analogue sources 

from the analogue input card used for the room correction 

measurements. In order to improve your overall system reorganise 

wiring to remove the hum loop. 

Hum may also be picked up by the lead from the microphone/SPL 

meter. It is best to use a shielded cable to reduce the chances of 

picking up hum. 
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